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Introduction 
 

e all use Outlook. It’s easy. You can answer email, keep your appointments and your 
calendar, and save your files in various folders. But are you using it to manage your 

entire workflow? You can. 
 

Few of us have unleashed the full potential of this powerful tool. That’s why we developed a 
webinar to help you squeeze maximum benefit out of Outlook. It’s no surprise that our 
Microsoft Outlook webinar became one of our most popular events ever.  

That’s why we’ve compiled an executive summary of this webinar, presented by a Certified 
Microsoft Office Master Instructor. Presenter Melissa P. Esquibel combines her 25+ years of 
experience in information technology with a background in training, technical writing and 
business risk analysis. Her goal is to move beyond email and help you understand Outlook’s 
amazing workflow benefits. 

You’ll discover how to get more out of Outlook than you ever dreamed possible. This is your 
hands-on road map to Outlook that can send your productivity skyrocketing.  

You’ll learn shortcuts on: 

 Powerful drag and drop techniques to end typing 
 Tricks on how to send notes to a contact or an email to your calendar 
 Creating Notes to minimize interruptions 
 Using Outlook to sort your mail 
 Organizing your files with flags, colors, categories, emails and alerts 

Microsoft Email: Outlook Tips and Training may not change your outlook on life. But it will 
definitely change your life on Outlook.  
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by Melissa P. Esquibel 

Road Map to Outlook 
 

We’re going to start with a few shortcuts and tips for moving around in Outlook quickly and 

smoothly. I’m a big fan of the keyboard shortcut. Sure, I use the mouse, too. However, if I can 
find a keyboard shortcut that lets me keep my hands on the keyboard—instead of taking my 
eyes off the screen, moving my hand to the mouse, refocusing on the screen, navigating, 
clicking, repositioning my hand on the keyboard and refocusing on the screen—I’m going to 
try to incorporate it into the way I work.  Most of us don’t even realize how much time we 
waste using the mouse when we could just stay on the keyboard. 
 
Then we’re going to learn an effective way to deal with interruptions, right in Outlook. If you 
work with Outlook open most of the day, this is a foolproof way to capture the important 
information that sometimes occurs during an interruption. And, in such a way that it doesn’t 
significantly interrupt the work you already have in progress.  
 
After that, we’ll explore how to tame the mess that is our inbox by using automatic color 
coding and folder filing in a “set-it and forget-it way” that basically lets Outlook sort our mail 
for us! 
  

Work … work … work 
 
Work … work … work. What is it? How do we get it and from whom? When we get it, how do we manage it to 
make sure everything gets done? Work is the things that we do, the planning process to get it done and the 
information we receive in order to do the doing. How do we normally receive work? 

 We get assignments when we attend meetings. 

 We have appointments on our calendar. 

 We get stuff in the mail like invitations and notices about events or bills coming due. 

 We get people dropping by our offices to let us know about something important, or not important. 

 The phone rings and we find out that we’ve just been asked to fill in for someone who’s out sick or that 
our spouse or roommate needs us to pick something up on the way home. 

 Of course, all day long, there is email. Email we care about, email we don’t care about. Important 
messages, not-so-important messages, and what I like to call career opportunity emails. Those are the 
ones that if we don’t act in the moment we get them, we may miss an opportunity for a new career. 

 The other kind of work we get is what we create with our own brilliant brains!  Most of us can relate to 
having a great idea and then seeing it on TV a year later, just knowing that the person who took action 
on it is making millions.  If we don’t capture these “light bulb” moments when they occur, we will likely 
forget about them until someone else reaps the benefit. 

Where do we manage all this work? Well, there you have it, EVERYWHERE—on paper, in voice mail, email, 
computer files and in Outlook, too. It’s like a juggling act, isn’t it? 
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Finding and Using Keyboard Shortcuts 
 
Let’s start with some of those keyboard shortcuts I mentioned. Many of us Microsoft® Office users wish they 
would put these shortcuts in one handy-to-reference place in each application. Well, in Outlook they did!  
Check this out. Look in the Go drop-down menu.  
 

 
 
Here is where you can click to navigate to each of Outlook’s components. However, look on the right of each 
one—there’s the keyboard shortcut to quickly navigate to it. (See Figure 1.) So, from here in Outlook, I can 
simply press Ctrl 3 to get to my contacts, Ctrl 2 to get to my calendar and Ctrl 1 to get to my mail, without EVER 
taking my hands off the keyboard. Look, ma, no mouse!  
 
The other place to look is in the File drop-down menu, which, by the way, you can get to with Alt-F. Just look at 
the underlined letters in each drop-down for how to use your Alt key instead of your mouse to access drop-
down menus. So, Alt-F and the underlined W key get me to this list.  
 

 
 

Look at the shortcut combos on the right. (See Figure 2.) Ctrl-Shift-M gets me into a new email message, no 
matter where I am in Outlook! Ctrl-Shift-A gets me into a new appointment in my calendar.  
 

ALT F W 

ALT G 

Figure 1 

Figure 2 
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Another great shortcut is the F9 key. Many of us click with our mouse up to that Send/Receive button during 
the day to check new mail coming in or to make sure an email we’ve just composed gets out right away.  
Instead of doing that, just hit the F9 key! You’ll see the exchange happening right before your eyes! 
 

 
 
 
 

The Amazing Notes Feature 
 
Ever have one of those great light bulb thoughts? An idea for a new project or product? My girlfriend in 
Houston is a songwriter. Every time a great lyric line pops in her head, she grabs a sticky note to write it down.  
When the muse visits her in the car, by the time she gets home, her steering wheel and dash are dotted with 
sticky notes she’s written at stoplights and stop signs. Most of us don’t have memories that will sustain a day 
full of information and activity and still remember that great idea we had first thing this morning when we got 
into the office. Rather than grab a sticky note, use Outlook Notes. When it’s not hard to record our random 
thoughts and great ideas, we’re more likely to do it!  
 
A less happy time in our day might be interruptions. The Bureau of Labor Statistics reports that interruptions 
cost U.S. companies almost $6 billion a year.  $6 BILLION! Not all interruptions are created equal. The chatty 
co-worker who drops by to see if we’re free for an after-hours get-together can be politely dismissed with a 
smile and a “I’ll let you know in a bit, OK?” but the boss dropping by or the client calling us may not be so easily 
dismissed. Closing down our current task and focusing our attention on the new task costs valuable time, and 
it’s not always warranted. For example, I’ll get a call from a client who’s asking if I can do a Microsoft® Excel 
Webinar sometime this fall. My answer is “I’m sure I can. What’s the best number to call you at after 3 p.m. 
today to discuss it?” Here’s what’s going on in Outlook during that phone call: 
 
“Hi, Melissa! It’s Jane from XYZ Corporation. I’m calling to see if you’d be available to do a webinar this fall on 
Microsoft® Excel.”  
 
“Well, I’m sure I can. I’m sure I have openings in my schedule for that, what’s the best number to reach you at 
after 3:00 today to discuss it?”  
 
“OK, 773-555-1212.”  
 
“All right, great, thank you so much for calling and I will talk to you about it this afternoon.”  
 
And everything is then captured in the note. I haven’t lost anything. I didn’t have to necessarily stop everything 
I was doing. I don’t have to go from a written piece of paper into an email, enter my calendar item. I just have it 
recorded. 
 

F9 

Figure 3 



-------------------------------------------------------- Microsoft Email: Outlook Tips and Training 
 

6 

 
So, let’s see what I did here.  As soon as I picked up the phone, I hit Ctrl-Shift-N. I could have also clicked down 
here and then here (see Figure 4 below) to create a new note. What I love about Notes is that they’re free-form.  
I don’t have to worry about being in the right field or typing the right sort of input. As Jane is talking, I’m typing. 
I haven’t eliminated the interruption, but I didn’t let it undo my day, either. 
 

 

 

 
Several times during the day, when I get some space between one task and another, I might go into my notes 
and decide to schedule this call with Jane on my calendar, or flag it somehow to indicate its priority. In this case, 
right before I go to lunch, I’m going to categorize it as New Business. (We’ll visit Categories shortly.) Later on, I 
might decide to go ahead and create a bona fide appointment on my calendar, like this … Drag … Drop. (See 
Figures 6 and 7.)  All I need to do is complete or copy and paste the new information required for the 
appointment, and close and save it. Now if I wish, I can remove it from my Notes page because it will pop up on 
my screen as a reminder with all the information I typed in to start with. 
 

 

 

  

 
 

Figure 4 Figure 5 

Figure 6 Figure 7 
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Think about it, you can drag and drop:  
 

 Note to a Contact 

 Contact to an Email 

 Email to a Calendar Appointment 

 Appointment to a Note 
 
By using the great shortcut, you can stop typing the same information over and over again. This is Outlook’s 
way of supporting “Repurpose, reuse, recycle.” 
 
Remember you can find shortcuts on the Go drop-down menu and on the File-New menu selection. Don’t 
forget about F9 for Send/Receive your email. 
 
 

Using the Notes space 
 
So, just how do I use the Notes space? 
 
My work flow goes like this: As the phone rings, as people stop by, if I have an occasion to write a note or have 
one of those brilliant light bulb moments, I will actually create the note, and at the end of every day I clear my 
notes. I leave anything that I haven’t decided what it is yet and everything else either gets “Dragged and 
Dropped” into a calendar item, an email or a contact, and then I delete it in Notes. I will also use that space on 
the Notes screen almost as a desktop.  
 
You know how you have your important pile and your not-so-important pile? I arrange my Notes screening 
exactly like that. And I do use color coding extensively so I can see where my focus is. 

 

 Figure 8 
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Email as Your Personal Assistant 
 
The most common use for Outlook, of course, is email. Yet few of us know that Outlook can go beyond just 
being a giant inbox to collect email. It can actually act as a personal assistant to us by sorting and labeling email 
before we even see it! 
 
Some of us have already created folders for different categories of email, such as email from particular people, 
companies or about certain topics. As you can see from my inbox (see Figure 11 below), I have several folders 
and even subfolders. While it’s easy to drag and drop emails to folders manually, you can have Outlook do it 
automatically (see page 11).  
 
Another great prep-step Outlook can do is color-code email so that we can easily pick out which emails require 
our immediate attention, can be forwarded for action by someone else, or which can wait till later to even 
open. Before we look at the “automagical” steps that Outlook can do, let’s explore the basics of folders and 
color coding. 
 
For those of you who haven’t experimented with folders and subfolders, let me quickly show you how to create 
a new folder. From the location under which you want to create the folder, type Ctrl-Shift-E. This will bring up 
the Create New Folder dialog box. You can also access this dialog box from either the File drop-down menu or 
by right-clicking on a folder and selecting New Folder. 

 
 
 
 
 
 
 
 
 
 

 

 

 

 
 

Figure 9 Figure 10 Figure 11 
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Let’s look at another way to organize our mail: color. Outlook gives us the ability to color-code just about 
everything, from email to notes and calendar appointments.  
 
By right-clicking on any item, you’ll see the Categorize option, which then allows you to choose an existing 
category or create a new one by selecting All Categories. Here we can click on the New button, give our category 
a name and then select a color for it. (See Figure 12.) 
 
You can have up to 25 different categories using this option. You can also rename or delete categories from this 
dialog box. We got here by right-clicking on an item and then selecting Categorize. 
 

 

 
 
 

 

 
 
 

 

 

 
 
You will also find this option on your Action drop-down menu, which you can access with the keyboard 
sequence: Alt-A, I and A. (See Figure 14.) Notice on the far right of this email, in the Categories column, you see 
the category color and name.  
 

 
 
But I don’t have to decide from just this limited set of information in which category it belongs. I actually have 
the option after I open the item, on the Message tab, in the Options group.  (See Figure 16, page 10.) You can 
use categories anywhere in Outlook.   

Figure 12 Figure 13 Figure 14 

Figure 15 



-------------------------------------------------------- Microsoft Email: Outlook Tips and Training 
 

10 

 
 
Another way to mark emails for action is by using Flags.  See these little grey or ghost flags over here on the right 
of this email? (See Figure 17, below.)  If I click it, the flag turns red. This is a good indicator of something I need 
to follow up on or something that requires additional prioritization.  
 
Notice that if I right-click on this flag, I can even set it for follow-up at different times. You can then create a 
reminder to pop up when the item’s follow-up time is coming up. When you click a flagged item, you’ll see a 
check mark. This is how you indicate that the follow-up activity is complete. You can remove a flag by right-
clicking and selecting Clear Flag. 

 

 

 
 

Another way to use colors is to actually highlight the text of an item in the view in color. Using the Tools menu 
option, Organize, then the Using Colors selection, I can choose a color for someone’s email to appear in as soon 
as it comes in! (See Figure 21, page 11.)   
 
This is a great way to quickly spot emails coming in that you may need to take action on immediately! You 
remember, the ones I call career opportunity emails? 
 
When you no longer need a particular kind of color coding, you can click here, on Automatic Formatting, to 
delete it. It’s also from here that you can choose to change any other type of color coding that’s set. If you want 
all your unread email to show up in a different font, you can! 
 

Figure 16 

Figure 17 

Figure 19 Figure 18 
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Click to close

 

 
Here’s my recommendation on this feature: Choose colors judiciously. If you’re only going to use a few, choose 
very different colors, like red and blue. If you will be using colors that are similar, like teal and green, you may 
also want to choose a different font. I think you could make a really good case for less is more when it comes to 
Tools-Organize. You can make the Organize selections go away, by clicking the X . (See Figure 22.) 
 
Like Tools-Organize, which automatically changes the text color of an item in a view, Rules and Alerts can 
automatically categorize, folder, forward and even delete an email when it first comes in!  
 
Let’s explore Rules and Alerts. Let’s say we’d like to have all email from a particular company go into a certain 
folder. We want it to remain showing as unread, but we don’t want it to stay in the main inbox.  
 
Let’s take these emails from the National Institute of Business Management. Anytime an email comes in from 
someone from NIBM, I would like it to go to a folder called NIBM here under MPELLC. So, first I create a folder 
under MPELLC, called NIBM.   
 
Now that I have the folder set up, I can click on Tools–Rules & Alerts or type Alt T, L and choose New Rule. I like 
to start from a Blank Rule. In this case it would be “Check messages when they arrive.” Then I’ll click the next 
button. For this purpose, I might check this box: “with specific words in the recipient’s address.” To specify what 
those would be, I’d click here where it shows “specific words.” After typing them in and clicking Add, I can 
choose OK and then Next. (See Figure 23, page 12.) 
 
The first option here would work best: “move it to the specified folder.” To tell it which folder, I’d click here on 
the word “specified.” Notice that I have to expand the Inbox folder by clicking on the plus and then the MPELLC 
folder, as well, to find NIBM. I could have also created the folder right here, using the new button. I can even 
specify exceptions to the rule if I like. I’m just going to click Finish.  
 
On this screen I can decide to run the Rules now or just save it to run the next time mail comes in. I’m going to 
choose to run it now and just click Finish. 

Figure 20 Figure 21 Figure 22 
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To recap: 
 Tools > Rules and Alerts … 
 New Rule 
 Start from a blank rule 
 Check messages when they arrive 
 Choose Condition 
 Choose Action 
 Specify Exceptions 
 Run and Finish 

  

Take a few moments and jot down some ideas for ways to use these organizing tools, like the color coding you 
can do in Organize, Rules and Alerts, Flags and Color Coded categories. Got a few ideas? Good! 
 
A gentle reminder here: One of my favorite speakers, Dr. Tom Miller, talks about the old brain and the new brain 
as the horse and rider. The horse, or the old brain, knows how to walk, talk, eat with a fork, drive a car—all 
those things you don’t even think about anymore. The rider just got done jotting down all those new ideas!  The 
rider is saying, “Have my mail sorted and notated automatically! You bet! Why wouldn’t I do that?”   
 
Later, when you’re sitting at your Outlook Inbox thinking, “Yeah, I’m going to do that Rules thing, you bet, 
absolutely, NEXT TIME, did you hear the horse jump in at the end with “next time?” Generally speaking, “next 
time” is never. So take action on those things you just jotted down as soon as possible. Just pat the horse on the 
head, give him some hay and do what needs to be done to make your email life easier, starting today. 
 
So, clearly, Outlook is for more than managing email and appointments. Use it to organize your entire workflow. 
And learn shortcuts! You will improve both your speed and accuracy in Outlook by learning to use the shortcuts 
rather than using the mouse all the time. 
 
 

 
 
 

 

Figure 23 
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special occasions; business letter and email protocol—and even how your office decorations may affect your 

professional image. 
 
www.businessmanagementdaily.com/BusinessEtiquette101 
 
 

 

12 Ways to Optimize Your Employee Benefits Program: Low-cost 

employee incentives, recognition programs and employee rewards   
 
If you’ve had to cut pay and staff and now expect more from those who remain, it’s vital to revamp your employee 

recognition and rewards program. Employers can double their rewards and recognition efforts in innovative, cost-

efficient ways with employee-of-the-month awards, employee incentive pay, employee appreciation luncheons, more 

time off, shopping sprees, wellness incentive contests, plus employee rewards customized to motivate Millennials, Gen 

Xers, Baby Boomers and the Matures. Now is the time to get clever with your employee recognition programs. This 

report shows you how with great ideas offered up from our Business Management Daily readers. 

 

www.businessmanagementdaily.com/EmployeeBenefitsProgram 

  
 
 
The Case in Point Yearbook: Real-Life Employment Law Advice … from Mindy 
Chapman’s Case in Point blog 
 

Mindy Chapman, Esq., has been providing sound employment law advice in her Case in Point blog since 2007. In her 

trademark entertaining style, she dissects an important employment law court ruling and provides essential 

employment law advice via three "Lessons Learned." Topics include: ADA guidelines, age discrimination cases, sexual 

harassment laws, EEOC cases, FMLA requirements and more.  

 
www.businessmanagementdaily.com/CIPYearbook 

 
 
 
The Bully Boss Strikes Again! How to deal with bosses who make crazy 
requests 
 
And you thought your boss was unreasonable? Bet he never asked you to perform oral surgery or fill in for the bomb 

squad. Talk about “other duties as assigned!” Even if your direct supervisor swamps you with petty tasks and doesn’t 

appreciate all you do, you can always “manage up” to make sure the boss’s boss knows your worth. This report 

includes practical advice on how to manage a toxic boss along with dozens of outrageous stories about bully bosses. 

 

http://www.businessmanagementdaily.com/BullyBoss 
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Microsoft Email: Outlook Tips & Training: How to improve productivity by 
effectively employing under-used features already at your fingertips 
 
We all use Outlook. It’s easy. You can answer email, keep your appointments and your calendar, and save your files in 

various folders. But are you using it to manage your entire workflow? You can. Melissa P. Esquibel combines her 25+ 

years of experience in information technology with a background in training, technical writing and business risk 

analysis to move beyond email and help you understand Outlook’s amazing workflow benefits. You’ll discover how to 

get more out of Outlook than you ever dreamed possible with this hands-on road map to Outlook that can send your 

productivity skyrocketing. 
 

http://www.businessmanagementdaily.com/MicrosoftEmailOutlook  

 

 

 

17 Team Building Ideas: The team building kit for managers with team 
building exercises, activities and games to build winning teams today! 
 
With employees still reeling from workplace budget cuts, now’s a great time for new team building ideas. No, you don’t 

need an expensive round of paintball to gain the benefits of team building exercises, but you do need to squeeze the 

most out of them. This report provides teamwork examples, exercises and tips for leading winning teams. Go from 

being a manager who oversees people to a leader who molds them into winning teams with these 17 team building 

ideas. 
 
www.businessmanagementdaily.com/TeamBuildingIdeas 
 
 
 
10 Time Management Tips: A how-to guide on efficiently managing your time 
through effective delegating, calendar management and using productivity tools 
 

In this era of downsizing and the quest for efficiency, businesses of all sizes are asking employees to take on extra tasks 

to boost productivity. Has your job turned into one of those “stretch jobs”? If so, you may be looking for a better way 

to get more done in less time, reduce stress and stop burning the midnight oil. Read about calendar management, 

keyboard shortcuts, running productive meetings, setting up agenda templates and using tech tools for project 

management with these 10 time management tips. Learn to prioritize your tasks and stop working in a crisis mode all 

the time 

 
www.businessmanagementdaily.com/TimeManagementTips 
. 
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About Business Management Daily 
 

Business Management Daily is a free news website of the Capitol Information Group, 

providing sound news and advice since 1937. 

 

At Business Management Daily, we’re driven to help organizations and individuals 

succeed. That’s why we deliver plain-English, actionable advice to high-performers at 

over 80,000 companies of all sizes across hundreds of different industries.  

 

Our Free Email Newsletters, Print Newsletters, Free Special Reports and Webinars, 

Podcasts, Audio Conferences & CDs help provide business professionals with the news, 

skills and strategies they need to grow their business, avoid legal pitfalls and advance 

their careers.  

 

Our editorial team includes experienced managers, leaders, HR professionals, lawyers, 

administrative professionals, CPAs, strategists and business owners from a wide variety 

of industries. 

 

A Promise to Our Readers  
 

To help you advance your career or business, we will: 

 

 Provide expert advice that is accurate, intelligent and timely  

 Save you time by making that advice concise, actionable and available in your 

preferred format  

 Guarantee 100% satisfaction with customer service that exceeds your 

expectations 

 

Visit us at:  http://www.businessmanagementdaily.com/ 
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